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Introduction
Enterprise Sync delivers fast, efficient change management for mainframe development teams. By
replicating mainframe source code to a distributed software configuration management platform, Enterprise
Sync increases the effectiveness of parallel application development activities. Modern GUI-based tooling
improves code change through automation, increased visibility, and simplified conflict and change
resolution. Changes made to the distributed source management platform synchronize automatically with
the mainframe software change management system. This ensures software change and configuration
management processes and mainframe application source code remain the primary system of record.

Key Benefits
Increased
Efficiency

Developer efficiency can be increased dramatically by working directly from a
modern Eclipse-based development IDE and using modern tools for automated
code merge and code change visualization.

Reduced
Mainframe
Reliance

Integration with Windows-based Continuous Integration and access to mainframe
test regions running on Micro Focus Enterprise Test Server ensures improved
delivery without additional mainframe resources.

Improved Quality

Removing error-prone manual processes for retrofitting changes across different
parallel source streams reduces the risk of introducing errors.

Accelerated
Developer
Adoption

By integrating and synchronizing with current mainframe delivery processes and
source hierarchies, Enterprise Sync offers an easy-to-learn improvement to tried
and trusted practices.

For more information, refer to the Data Sheet.

Complementary Enterprise Products
Enterprise Sync is part of the Micro Focus Enterprise Portfolio which includes:
Micro Focus
Enterprise
Analyzer

A comprehensive solution for understanding application portfolios. It provides a
centralized repository offering technical insight into application inventory, structure
and dependencies, while providing insight into the impact of change across
enterprise systems.

Enterprise
Developer for z
Systems

A full-function mainframe development environment for Eclipse or Microsoft Visual
Studio. It offers developers modern tools to develop, compile, debug and test
applications on or off the mainframe with no wait times or resource contention.
The installation of Enterprise Developer is a pre-requisite for Enterprise Sync.

Enterprise Test
Server
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A mainframe application test execution environment on Windows offering mainframe
testing on low cost commodity hardware. Test capacity can be scaled up on demand
to easily to meet business-driven delivery time-lines.

Components
Enterprise Sync is a series of components that allows you to connect your mainframe Endevor system to a
distributed source control system. The bundle is comprised of the following products. Part of this document
will walk you through the installation process.
There are two key parts to Enterprise Sync:
•
•

The server piece that mirrors and synchronizes Endevor assets in a distributed platform.
The client tools that are driven from Enterprise Developer for z Systems that provide modern SCM
tooling regardless of where the source resides - mainframe or distributed.

The components in the Enterprise Sync solution communicate with each other in the following manner:

Server Components
Micro Focus Mainframe Access Server
Mainframe Access Server is a mainframe server component that communicates with Endevor.

Components
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Enterprise Sync Server
The Micro Focus Enterprise Sync Server components synchronize sources and meta data between the
SCM on the mainframe and sources managed on a distributed platform. The server components that make
up Enterprise Sync include:
Mainframe Access Communicates with Mainframe SCCM through the MFA Server.
Client
AccuRev Client

End-users and client programs perform operations on the AccuRev client.
Operations can take place from the command line, AccuRev GUI, Web UI, or
through an IDE Plugin. The client process is installed as part of the installation and
communicates with the server process.

Micro Focus
Connect

Manages and performs the synchronization process. It is the web-based interface
for creating your configurations. It is often referred to as the Dashboard in this
documentation.

AccuRev Server
AccuRev is a centralized version control system which uses a client/server model. The AccuRev Server
maintains all the source and metadata within a data repository. The data repository is built around a
database technology that is transaction-based and manages the tables as append-only. There is a server
process installed as part of the AccuRev Server that manages the AccuRev repositories and handles all
communication between the server and the AccuRev clients.
Micro Focus Workflow Manager Endevor Attachment
An Application Workflow Manager model that provides integration to Endevor and AccuRev tools and
processes directly from an Enterprise Developer Eclipse project. Refer to the Enterprise Developer
documentation for more details.

Client Components
AccuRev Client
Windows based GUI to allow developer to access version controlled source assets managed in the
AccuRev Server.
AccuRev Eclipse and AWM AccuRev Integration Plugin
Provides access to version controlled source assets directly from the Enterprise Developer Eclipse IDE.
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Concepts
General Concepts
Enterprise Sync mirrors a mainframe SCM system with a distributed SCM system based on the following
general concepts:

Data Source
An Enterprise Sync Data Source is representing an external SCM systems. Typical values which have to
be associated when describing a Data Source are:
•
•

Information how to access the SCM system (server address, port).
Required credentials to get access to the SCM system.

Connection
An Enterprise Sync Connection defines two external SCM systems for synchronization by associating two
Data Sources to the connection. One Data Source must be defined as the Master and the other as Target.
Normally the mainframe SCM system with the already existing files will be defined as Master within a
connection and the distributed SCM system which will receive the files during an initial synchronization will
be defined as the Target.
It depends on the specific connection, which rules apply for Master and Target Data Sources. Following are
examples which could be implemented:
•
•

In case of conflicts, for example a file is changed in parallel in both SCM systems, the conflict has to be
resolved in the target SCM system.
Deleted files in the target SCM system relevant for synchronizing are not deleted in the master system,
but synchronized again from the master to the target system.

At least one Project must be added to a connection (see Project), before the synchronization process can
be started.
A synchronization process is enabled by starting a Connection and disabled by stopping a Connection.
A Connector is a software implementation providing access to an external SCM system.
It depends on the specific implementation of a Connector whether the synchronization process is executed
based on a configured time interval, for example all 30 minutes, or is executed on demand based on user
actions, for example an executed check-in function could trigger the synchronization process for the
corresponding files.

Concepts
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Project
Projects are associated to a connection. One project defines a specific synchronization rule, for example:
•
•

Synchronize all production files belonging to the Finance application from the Master Data Source to
the Target Data Source.
Synchronize all files of the Staff application which were added to a Test stage between Master and
Target Data Source (bi-directional).

One Project defines unique criteria for identifying assets in the corresponding SCM systems and defines
unique mapping rules how to map these assets between both SCM systems.
A project can define a one-directional or a bi-directional synchronization rule, either:
•
•
•

From Master
From Target
Bi-directional

Within a connection, a specific project can be enabled or disabled. If disabled, this project definition is not
used for synchronizing assets.

Endevor/AccuRev Synchronization Support
General Considerations
Enterprise Sync contains connectors for Micro Focus AccuRev and CA Endevor Software Change
Manager. Based on these connectors, the synchronization process between both products can be
configured and implemented.
An Endevor/AccuRev Connection supports the following main synchronization features:
•

Endevor can be defined as the Master Data Source and AccuRev as the Target Data Source when
creating a connection.
Note: The current release does not support AccuRev as Master.

•

One or more combinations of an Endevor environment, stage, system and subsystem can be mapped
to one AccuRev stream.
Normally the AccuRev stream hierarchy would be defined similar to the stage hierarchy (map) in
Endevor. It depends on the specific use case whether Endevor systems/subsystems are mapped into
one to different streams.
For clearness reasons Micro Focus recommends to map different Endevor systems to different
AccuRev streams.
The following sample shows an Endevor stage structure mapped to an AccuRev stream structure,
where the Endevor systems Bankdemo and Staff are mapped to different stream sets.
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•

Note: We recommend not synchronizing Endevor elements directly into the AccuRev root stream.
Keeping the AccuRev root stream empty has advantages if a stream restructuring is required.
The default stream directory structure contains the Endevor system as the root folder name
which contains the Endevor subsystem folder, which contains the Endevor type folder. Any other
directory structure can be configured with the following restrictions:
•
•

•

•

The Endevor type name must be the stream a folder which contains the synchronized Endevor
elements.
The directory structure must support a unique file mapping between AccuRev and Endevor.

Example: If a stream contains only files of one Endevor subsystem, it is not required to configure the
Endevor system and subsystem name in the directory structure.
The synchronization rules can be defined one- or bi-directional.

The synchronization from Endevor to AccuRev is triggered based on a configured time interval (for
example all 30 minutes).
Note: Enterprise Sync does not support an on demand synchronization from Endevor to AccuRev.
This synchronization direction is always based on a configured time interval.
Enterprise Syncs searches changed Endevor elements and changed Endevor metadata in all
configured environments, stages, systems and subsystems. If only metadata have changed then only
the metadata are synchronized and not the file content.

Concepts
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•

The synchronization from AccuRev to Endevor is either triggered based on a configured time interval
(for example all 30 minutes) or on demand when promoting files to an AccuRev gated stream whose
parent stream is supporting a synchronization to Endevor.

Metadata Synchronization Support
The synchronization process supports metadata changes in Endevor and the synchronization of the
following file based metadata:
Metadata name

Description

Sample value

ContentType

The synchronized Type in AccuRev. Text or
Ptext or Binary

Text

Component VVLL

the component's version and level number

0105

Element Name

BBANK10P

Element Type

COBOL

Element VVLL

the element's version and level number

0100

Endevor Environment

SMPLPROD

Endevor Subsystem

BANKDEMO

Endevor System

MFISYS

Generate Date

Last generation date

16/11/15

Generate Time

Last generation time

04:02:00

Generate User

Last user who has generated the file

MFIXXX

Last Action CCID

SYNCDEMO

Last Action Comment

SYNC DEMONSTRATION

Last Action Date

16/11/15

Last Action Name

SIGNIN

Last Action RC

Last action return code

00000

Last Action Time

04:03:01

Last Action User

MFIXXX

Nosource

Is true, if no source is associated to the
element in Endevor

Processor Group

false
CICS

Processor RC

Return code of the processor

00004

ReadOnly

Is true, if the file is configured to be read-only in false
AccuRev. This value is a result of a
configuration rule.

Signout User

Contains only a user value, if the element is
signed-out

MFIXXX

Stage ID

P

Stage Name

PROD

Stage Number

2

Update Date

16/11/15

Update Time

04:03:01

In addition the following environment, stage, system or type specific metadata are synchronized to
AccuRev:
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Metadata name

Description

Sample value

Extension

The element extension from Endevor (not the
extension configured in Enterprise Sync)

CBL

Processor Group
Name

List of valid Processor Groups

CICS, CICSSP, CLENBL

Record Length

Valid record length

00080

Text/Binary

The content type in Endevor: T or B

T

Some metadata are required by Enterprise Sync functions, for example:
•
•
•

Creating files in AccuRev with the required file extension
Validating the record length of a file edited in Enterprise Developer mainframe projects.
Offering a selection field for valid Processor Groups when promoting files to a gated stream.

The metadata are managed in AccuRev as stream properties. The file specific metadata are stored in the
same stream where the file exists.
Enterprise Sync related project metadata are also stored in the corresponding stream.
All other metadata are stored as stream properties in the root stream.
Most of the metadata are displayed in the Enterprise Developer's Property View when selecting a file in the
Team Developer perspective which is linked to AccuRev.
Although AccuRev file metadata are not synchronized to Endevor, Enterprise Sync supports accessing
these metadata in Enterprise Developer.
The Properties view displays the following AccuRev metadata:
Metadata name

Description

Sample value

Element-ID

This is a unique identifier for an AccuRev resource
within its depot

388

Element Type

Describes the content type of the resource in AccuRev.
The valid values for the properties are TEXT, PTEXT or
BINARY.

PTEXT

Is Project shared
with AccuRev

Whether the corresponding Eclipse project is shared
with AccuRev. Valid values are true or false

00080

Pathname

Describes the location of an AccuRev resource.

\.\COBOL\BBANK10P.cbl

Status

File statuses in AccuRev are for example: backed or
modified .

(backed)

Stream

The (backed) stream name of an AccuRev resource

BANKDEMO_TEST

Stream Version

The stream version of an AccuRev resource

2

Version

The AccuRev Version name which is a concatenation of BANKDEMO_TEST/2
Stream and Stream Version

The AWM model based integration of AccuRev and Endevor in Enterprise Developer supports accessing
the corresponding file metadata where required. By default the supported metadata are displayed in the
Properties view, some are visible as label decorators in the tree view and others as column values in the
table views.
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On-Demand Synchronization Support
The synchronization from AccuRev to Endevor is either triggered based on a configured time interval (for
example all 30 minutes) or on demand when promoting files to an AccuRev gated stream whose parent
stream is supporting a synchronization to Endevor.
Note: Based on the Endevor technology for adding files to an Endevor repository Micro Focus
strongly recommends to configure an on demand synchronization process for all synchronizations
from AccuRev to Endevor, because the on demand synchronization process uses the credentials of
the user who has executed the promote in AccuRev and his corresponding mainframe credentials are
used to sign-out the elements in Endevor.
In addition, the on demand synchronization process has some other advantages.
•
•

Enterprise Developer users get immediate feedback when their changes are synchronized to Endevor.
Enterprise Developer get visible reasons why a synchronization failed, for example

•

• On demand synchronization failed because of overlapped elements \.\COBOL\MYFILEA.CBL.
• On demand synchronization failed because the Endevor element MYFILEA is signed-out to MFIXXX.
The user can perform typical actions to resolve synchronization failures, for example:
•
•
•

Demote change back to workspace.
Merge changes.
Re-promote.

The following is required for supporting on demand synchronizations:
•
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The Enterprise Sync projects definition requires a defined bi-directional synchronization rule from an
AccuRev dynamic stream to Endevor like in the following sample:

•

Based on the projects definition show in the sample above the stream structure which would support an
on demand synchronization to the Endevor TEST and EMER stage could be defined like in the following
sample:

In this sample, the stream BANKDEMO_TEST is mapped to the Endevor stage TEST bi-directionally. It is
required to define gated streams as children for all such streams to support on demand
synchronizations.
Thus, promoting files to the gated stream BANKDEMO_TEST_GATE triggers the on demand synchronization
to Endevor, and only if this synchronization is executed successfully, the files are promoted to the target
stream BANKDEMO_TEST.
When changes are promoted to the gated stream, the AccuRev server invokes a server-side trigger which
provides the on demand synchronization support. Therefore the following rules apply:
•
•

Enterprise Sync pauses the synchronization process which is based on time intervals.
Enterprise Sync synchronizes the current change to Endevor:
•

•

If the Endevor element is not signed-out, it is first signed-out to the user who has executed the
promote function.
• If the Endevor element is signed-out to another user and override sign-out is not specified on the
promote dialog, then a synchronization error will occur.
Enterprise Sync resumes typical syncing iterations

If AccuRev detects that a promote function will lead to an on demand synchronization, a specific promote
dialog pops up in Enterprise Developer which supports Endevor specific parameters:
•
•
•
•
•

•
•

The comment field is limited to 40 characters and entered text will be passed to the Endevor Comment
field.
The CCID is passed to Endevor when adding the related elements.
If the promote user is authorized in Endevor he could set a flag overriding existing sign-outs.
The user has the option to generate the element directly in Endevor.
For each single element in the promote list the processor group could be changed, if required. Normally
it is not required to select a processor group.
Note also the following processing rules relevant for the on demand synchronization process:
The promote dialog shown above has been optimized in Enterprise Developer, but is also available with
limited validations in the AccuRev Windows GUI.
If the Generate option is selected on the promote dialog, the Generate function is directly executed
when adding files to Endevor. This means it is executed synchronously within the Micro Focus Access
Server. If the Generate function fails, the element synchronization was still successful and Enterprise
Sync will return a warning message. Enterprise Developer supports accessing the compiler listing
directly on the mainframe, assuming that Endevor manages compiler listings.

Concepts
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•
•
•
•

Specific Endevor processors which are creating and running in a TSO or ISPF environment are
supported.
Submitting a Generate function for Batch execution is not supported.
If AccuRev change package support is activated, the promote dialog might look a little bit different (see
AccuRev Change Package Support).
If an on demand synchronization has been executed successfully, Enterprise Developer displays the
storage decorator on the AccuRev workspace icon with a green background , otherwise with a red
background and once a popup message is displayed containing the Endevor error message and the
Endevor message text.

Required Credentials
For an on demand synchronization process Enterprise Sync requires the AccuRev as well as the
mainframe credentials of the user who promotes files to the gated stream.
These credentials are prompted only once per session in Enterprise Developer. The second promote
should neither ask for the AccuRev nor for the mainframe credentials. If the Enterprise Developer user is
already connected to the mainframe (green background of the connection icons visible in the Remote
Systems view), then the Enterprise Sync authentication dialog will only prompt for once for the AccuRev
credentials.

Content Type Support
Enterprise Sync maintains the Endevor element types ( text/binary) during synchronizations. If a file is
binary in Endevor, it will also be a binary file in AccuRev after it is synchronized (and vice versa). If a file is
text in Endevor, it will be a ptext file in AccuRev and ptext files or text files in AccuRev will become text files
in Endevor.
Enterprise Sync accomplishes this via the following:
•
•
•

At initialization time, Enterprise Sync reads the Endevor configuration information and stores it as
stream properties in the mapped AccuRev depot (root stream).
When the AccuRev connector is generating change sets to be synchronized with Endevor, it will set the
content type for each file based on the info in the depot properties.
Similarly, when the AccuRev connector is applying change sets from Endevor, it will set the appropriate
content type when adding/updating elements in AccuRev.

Change Package Support
AccuRev change package support can be turned on in Enterprise Sync by setting specific attributes in the
AccuRev Data Source definition (see Creating a Data Source).
This support maps AccuRev change packages with Endevor elements which have a specific CCID value
associated.
There are two configuration options in Enterprise Sync:
•

You may want to associate files which are synchronized from Endevor to an AccuRev change package
depending on the last action CCID in Endevor.
Enterprise Sync supports this based on the following rules:
•

During an initial synchronization, Enterprise Sync does not assign the synchronized files to change
packages. This feature is only supported for incremental synchronizations.
Note: Before running an initial sync, make sure that the AccuRev schema definition is defined
in such a way that the synchronization user is allowed to add files to the streams without
enforcing the association to change package.
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When defining the change package triggers condition in your AccuRev schema you could, for
example, explicitly exclude the AccuRev streams which are mapped in Enterprise Sync to
Endevor stages:

•

•
•
•

•

•

If an AccuRev schema does not exist Enterprise Sync will generate a default schema.
Note: If change packages are used in AccuRev, we recommend creating the appropriate
schema with the required fields, queries and status rules before activating the change package
support in Enterprise Sync.
If an AccuRev schema exists, but does not have the configured CCID field associated, then
Enterprise Sync will add this field automatically to the schema.
During the synchronization Enterprise Sync detects the last action CCID associated to the Endevor
element.
If no change package has been created for that target stream which has the CCID value associated,
Enterprise Sync will create a new change package and will associate the file to that change
package.
Note: The corresponding change package depends on the target stream to avoid conflicts in
parallel development scenarios. Endevor doesn't assure that different CCIDs have to be used if
a file is changed in parallel in different Endevor stages. To avoid logical conflicts in AccuRev
different change packages are used in such constellations.
If change packages already exist for that target stream which has the CCID value associated, then
the file will be added to all those change packages.

Note: normally only one change package will exist related to the target stream which has a
specific CCID value associated. Anyhow, Enterprise Sync does not disallow additional manually
created change packages with the same CCID value.
You may want to associate the change package's CCID value to the Endevor elements for all files which
are synchronized from AccuRev to Endevor.
•

•

If the user promotes files to a gated stream and AccuRev is configured to force a change package
selection when promoting, then Enterprise Sync uses the CCID value which is associated to the
change package and associates this CCID to all synchronized Endevor elements.
If more than one change package has been selected when promoting files, then Enterprise Sync
uses the CCID value of the first selected change package.
Note: Although AccuRev allows the association of several change packages when promoting
files, Endevor does only support the association of one CCID value when adding an element to
the repository. To avoid logical conflicts it would be best practice implementing an

Concepts
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(organizational) rule and allowing only the association of one change package when promoting
files.
• If the user has selected a change package with an associated CCID value when promoting, the
promote dialog in Enterprise Developer will protect the CCID field, because the change package's
CCID value will be used. This value cannot be overridden by the promote user.
Note: Don't mix up the support for AccuRev change packages with Endevor packages. Enterprise
Sync does support AccuRev change packages mapped to Endevor CCIDs, but does not support the
generation or interpretation of Endevor packages. Of course, it is possible to create a custom
procedure which generates, an Endevor package with Move commands based on the synchronized
elements by interpreting the associated CCID value.

Mapping Rules
Endevor Stages are mapped to streams in AccuRev.
By default, when synchronizing files from Endevor to AccuRev, the Endevor logical element structure in
stages using system, subsystem and type are converted into directories within streams.
System FINANCE
Subsystem ACCTPAY
Type COBOL
File FINAPP01
This is translated to the following path structure: FINANCE\ACCTPAY\COBOL\FINAPP01.cbl.
There are, however, cases when you would want to overwrite this default behavior:
• The AccuRev stream structure has been designed using different streams for each Endevor system.
Therefore there is no need to have the system name in the path structure.
• The Endevor system or subsystem name changes when moving files in Endevor to the next stage.
Environment

SMPLPROD

SMPLTEST

SMPLTEST

SMPLTEST

SMPLTEST

Stage

PROD

QA

QA

TEST

TEST

System

FINANCE

FINANCEA

FINANCEB

FINANCEA

FINANCEB

Subsystem

ACCTPAY

ACCTPAY

ACCTPAY

ACCTPAY

ACCTPAY

Type

COBOL

COBOL

COBOL

COBOL

COBOL

File

FINAPP01

FINAPP01

FINAPP01

FINAPP01

FINAPP01

The sample above shows a typical Endevor scenario which can be used to support parallel
development in one Endevor environment by using a specific suffix in the system's name. When moving
files to the next environment the suffix is omitted.
For synchronizing files from Endevor to AccuRev you would normally require for the three stages used
in the sample above three corresponding AccuRev streams. But because Endevor system names were
used to support parallel release development it is required to create parallel streams in AccuRev. Even
more AccuRev requires a consistent directory structure in a stream hierarchy. This means the directory
structure cannot change when promoting files to the next stream. Therefore a stream structure like the
one shown below is required. The directory structure cannot be calculated by the default rules, but
should look like this one in all streams: ACCTPAY\COBOL\FINAPP01.cbl
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Enterprise Sync supports any kind of mappings from one or more combinations of Endevor
environment, stage, system and subsystem to a corresponding stream and any kind of mappings from a
combination of environment, system and subsystem to a configured directory path.
Using the example above you would create a property file with the following content:
SMPLPROD.FINANCE.ACCTPAY=acctpay
SMPLPROD.FINANCEA.ACCTPAY=acctpay
SMPLPROD.FINANCEB.ACCTPAY=acctpay
See Creating a Data Source for details how to configure this in Enterprise Sync.
Note: This path mapping does neither depend on the Endevor type nor on the stage. The Endevor
type must be part of the AccuRev directory structure and is therefore not required in the properties
file. The Endevor stage is not relevant, because a synchronization from AccuRev to Endevor only
updates the Endevor entry stage in an environment and therefore it is not required for Enterprise Sync
to know in which Endevor stage within an environment the systems and subsystems are valid names.

Promote/Move Synchronization Rules
The basic concept of Enterprise Sync is based on detecting and synchronizing changes between two SCM
systems.

Moving Files in Endevor
Enterprise Sync tries to synchronize an Endevor Move action as an AccuRev promote, if possible, although
the synchronization process is not triggered by the Endevor Move.
The following rules apply when Enterprise Sync detects a file change in a target stage:
If Enterprise Sync detects a file change in Endevor which should be synchronized to an AccuRev stream,
then it is verified whether this file version has been deleted in a source stage which is mapped to an
AccuRev child stream.
•
•

•

If so, then the file is promoted in AccuRev from the source stream to the target stream.
If either the file is not deleted in the source stage or the file content in the target stage differs from the
content in the AccuRev source stream, then the changes are updated in the corresponding streams and
no promote from the source stream to the target stream is executed.
Metadata are synchronized as usual. If a file is promoted or purged from a source stream then the
corresponding metadata are removed from this stream as well.

Promoting Change Sets in AccuRev
A file synchronization from AccuRev to Endevor always means adding this file to the corresponding entry
stage in Endevor.
Note: Based on Endevor rules updates in a stage 2 of an environment are not allowed and Enterprise
Sync does not support a Move operation in Endevor.
Therefore, the following mapping restrictions apply:
•
•

For an on demand synchronization the target stream for an AccuRev promote must be a gated stream
which is a child of a target stream mapped to an Endevor entry stage (stage 1).
For a synchronization based on time intervals the target stream for an AccuRev promote must be
mapped to an Endevor entry stage (stage 1).

Processing Endevor Sourceless Elements
Endevor supports sourceless elements. A sourceless element is like a linked element pointing to an
existing one in a higher stage. A sourceless element can only be created in Endevor using the Generate
command with the Nosource option.
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The synchronization process from AccuRev to Endevor will never create a sourceless element in Endevor.
If Enterprise Sync detects a sourceless element in an Endevor stage mapped to an AccuRev stream, then
Enterprise Sync synchronizes the corresponding physical file to AccuRev and associates the Endevor
metadata of the sourceless element.
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Installation
The topics in the section will walk you through configuring your systems and installing the required
components.
Note: Because Enterprise Sync 2.1 is a 32-bit application and Enterprise Sync 2.2 is a native 64-bit
application, there is no direct upgrade. Uninstall Enterprise Sync 2.1 before installing Enterprise Sync
2.2.

Installing Enterprise Sync Server
You will need the AccuRev Host Name/IP Address and Port during this installation.
Micro Focus supports the installation of the Enterprise Sync server on one of the following operating
systems:
•
•
•

Microsoft Windows Server 2012 SP2.
Microsoft Windows Server 2012.
Microsoft Windows Server 2008 (64-bit).

Required hardware:
•

64-bit, quad-core systems with 8-16 GB of memory.

If AccuRev is installed on one of the supported operating systems which are also supported by Enterprise
Sync, you could install the Enterprise Sync server on the same machine. If the Enterprise Sync server is
installed on another machine, make sure that your network connection to the AccuRev server provides
sufficient performance.
Use the following steps to install Enterprise Sync.
1. Using Administrator credentials, double click the installation media (enterprise-sync<version#>-win-64.exe) to start the install.
2. Click Next on the Introduction screen.
3. Read and accept the license agreement. Then click Next.
4. On the Choose Install Folder screen, either accept the default location or choose another one. If
Enterprise Sync is already installed you have to check the upgrade flag or uninstall Enterprise Sync first
if you would like to start from scratch. Click Next.
5. If it's an installation from scratch you have to specify the AccuRev server's access parameter. The
default port for accessing the AccuRev server is 5050. This dialog doesn't pop up when upgrading an
existing installation. Enter the Host Name and Port of the AccuRev server. Click Next.
6. On the Choose Shortcut Folder, enter the location for the product icons. Click Next.
7. Review the Pre-Installation Summary page and click Install to install the components.
8. When the wizard is finished, click Done.
Two Enterprise Sync Services were started automatically: Enterprise Sync Web Service and
EnterpriseSyncConnect.
To verify the installation:
1. Open the page http://localhost:8081/ConnectWeb in your browser.
2. Enter user Administrator and password Administrator.
3. Use the DefaultAuthenticator.
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4. Click Login.
Note: User name and password are case sensitive.
By installation default, the Enterprise Sync Web Service listens on port 8081. If you like to change
this port execute the following steps:
1. Stop the Enterprise Sync Web Service using the Windows Services utility.
2. Edit the file server.xml located in the installation directory, by default.
C:\Program Files\Micro Focus\Enterprise Sync\WebServer\conf.
3. Change the port 8081 using an appropriate port of your choice and then save the file.
4. Restart the Enterprise Sync Web Service.

Installing the AccuRev Server
Enterprise Sync requires the special AccuRev release 6.2.3-ES-HF1.
Note: Enterprise Sync does not support AccuRev 6.2.3 or AccuRev 7.
For the general system requirements for AccuRev and the installation instructions, please refer to the
AccuRev Installation and Release Notes: https://supportline.microfocus.com/productdoc.aspx .
If the AccuRev Server is installed on a Microsoft Windows-supported platform, Perl support has to be
installed in addition. Download the Perl distribution from https://www.perl.org/get.html. Use either the
commercial ActiveState Perl or the Strawberry Perl distribution.
Important: Some specific installation options are required when installing the AccuRev server.
Therefore, read the following instruction carefully before installing the AccuRev server.
Important: Disable Replica Support
If you are installing the AccuRev server on an existing database:
When installing and pointing to existing storage, you must truncate the
site.row_history_deleted table. There will be a log message at server startup: Enabling/
Disabling site replica triggers. For Enterprise Sync installation it needs to be
disabling.
Use the following psql command from the command line:
…\AccuRev\postgresql\bin\ psql -U postgres -d accurev -p 5075 -c "TRUNCATE
site.row_deleted_history;"
Verify the state of the replica triggers in the second line in acserver.log.
If this hasn't been done in the main AccuRev server log at the very beginning it will show:
yyyy/mm/dd 13:51:05.154+00:00 Enabled the site replica triggers
If it's fixed it show:
yyyy/mm/dd 07:27:48.103+00:00 Disabled the site replica triggers
1. Replicas are not supported in combination with Enterprise Sync. Therefore you must select the option
No replication when installing the AccuRev server.
2. The integration of Enterprise Sync in Enterprise Developer requires the AccuRev WebUI server. At the
end of your AccuRev server installation you may want to start the WebUI server directly.
Additional AccuRev server configuration steps are required for Enterprise Sync and for accessing the
AccuRev WebUI through Enterprise Developer. See chapter AccuRev Server Configuration for details
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Installing the AccuRev Windows Client
Enterprise Sync requires the special AccuRev release 6.2.3-ES-HF1.
Note: Enterprise Sync does neither support AccuRev 6.2.3 nor AccuRev 7
For the general system requirements for AccuRev and the installation instructions, please refer to the
AccuRev Installation and Release Notes: https://supportline.microfocus.com/productdoc.aspx .
Note: Although Micro Focus recommends to access AccuRev through the Enterprise Developer's
Eclipse based IDE, it is still required to have the AccuRev Windows client installed on the machine
where Enterprise Developer is installed.

Installing Enterprise Developer
The installation of Enterprise Developer for Eclipse is a pre-requisite for using Enterprise Sync. Refer to the
Release Notes for the supported version.
You will find the installation instructions for Enterprise Developer in the Micro Focus Documentation Info
Center .
The following installations are required:
Mainframe
installations

Supports the synchronization with CA Endevor as well as
Mainframe
Access Server accessing mainframe functions through Enterprise Developer. The
Enterprise Sync synchronization process requires the
communication with this server.
z/Server

Client
installations

Enterprise
Developer for
Eclipse Client

Supports the direct access to Endevor through Enterprise
Developer. If a direct mainframe connection in Enterprise
Developer is not required, then the z/Server installation is not
necessary. The Enterprise Sync synchronization process doesn't
use the z/Server.
The component has to be installed on all developer machines.
The integration with Enterprise Sync requires additional
installations. See:
•
•

Installing the AccuRev Eclipse Plugin
Installing the AWM AccuRev Function Package

Installing the Enterprise Sync Add Pack
The AccuRev Plug-In for Eclipse and the AWM AccuRev integration are included in the Enterprise Sync
Add Pack found in the Enterprise Sync distribution package. Open enterprise-sync-addpackx86.msi and follow the prompts to install.

Installing the Workflow Manager Endevor Model
The Workflow Manager (AWM) Endevor Attachment release 3.0 must be installed and configured.
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1. The specific AWM model NDVAC30 - which is part of the Workflow Manager Endevor Attachment - has
to be used to support the full integration of AccuRev, Endevor and Enterprise Development Projects into
Enterprise Developer.
2. You will find the installation instructions for the Workflow Manager Endevor Attachment in the Micro
Focus Documentation Info Center under Enterprise>Micro Focus Enterprise Developer for
Eclipse>General Reference>Application Workflow Manager>Workflow Manager Endeavor Attachment.
The Workflow Manager Endevor Attachment is installed on the mainframe and requires that Enterprise
Developer is fully installed and configured. The installation of this Endevor Attachment requires changes to
the z/Server installation.
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Administration
The topics in the section will walk you through configuring your systems and required components. It is
important to follow these procedures in the order that they are listed.

AccuRev Configuration
Enterprise Sync works with the AccuRev 6.2.3 release. For full installation/configuration procedures for the
AccuRev client and server, refer to the AccuRev Installation and Release Notes: https://
supportline.microfocus.com/productdoc.aspx.
The following sections are required to configure AccuRev with Enterprise Sync.

Define AccuRev User
When Enterprise Sync synchronizes files, it performs actions, such as adds and updates, as the correct
user. For example:
•
•

User AAA in Endevor is mapped to user aaa in AccuRev.
If Endevor user AAA adds file FOO.CBL in Endevor, Enterprise Sync will attempt the addition of
FOO.CBL in AccuRev as aaa.

The same is true for the opposite direction (AccuRev to Endevor). For this reason, it is important to follow
the procedures in this section to properly create and manage your users for all of your systems.
1. Define an AccuRev user that will be used later during the synchronization process. This user must have
a password defined (not optional).

Tip: You should define another user, named triggeruser with password triggeruser used in
the Perl script to trigger an on-demand synchronization process. Although you could use the same
user as defined above, we recommend using another user within the trigger because this has
advantages when debugging the synchronization process.
2. Create one AccuRev user for each Endevor user.
For each Endevor user (mainframe userid) who is updating elements in Endevor which are relevant for
the synchronization process it is strongly recommended to define a corresponding AccuRev user.
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If you don't do this you can still use Enterprise Sync for synchronizing Endevor elements with AccuRev,
but you will not see in AccuRev which file changes a specific mainframe user has done in Endevor. This
means that the AccuRev Annotate function would contain less specific information.
Following rules apply for defining this user:
•
•

No password is required.
Any valid AccuRev user name can be used. The mapping to the corresponding mainframe user is
done later when configuring Enterprise Sync.
Tip: We recommend defining at least one user group in AccuRev for all these users. This will allow
you to easily prevent the complete group from updating streams which are managed by the
synchronization process. But don't add the synchronization user and the trigger user to this group.

Define AccuRev Depot
Define at least one depot used as a target for synchronizing Endevor elements (we will use
MyEnterprise in these samples). In the AccuRev client use File > New > Depot…' to create a new
depot.

Define AccuRev Stream Structure
A Bankdemo sample is used to illustrate how to define one possible stream structure which is consistent
with the structure defined in Endevor. It is assumed that there are two Endevor environments with the
stages TEST and QA in environment SMPLTEST and with the stages EMER and PROD in environment
SMPLPROD. Further on we want to manage Endevor subsystems in different streams.
Note: This rule used here is not a restriction of Enterprise Sync, it's a design decision for this specific
sample. In general it is possible to synchronize several Endevor systems or subsystems into only one
AccuRev stream.
The following sample uses the streams BANKDEMO_PROD, BANKDEMO_EMER, BANKDEMO_QA,
BANKDEMO_TEST, BANKDEMO_TEST_GATE and BANKDEMO_EMER_GATE structured as shown in
the image below. It is assumed that the corresponding Endevor installation contains two Endevor
environments: environment SMPLPROD with the stage 1 EMER and stage 2 PROD and environment
SMPLTEST with stage 1 TEST and stage 2 QA.
Note:
•
•
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All streams used for synchronization must be defined in AccuRev before configuring the
synchronization rules.
We do not recommend using the root stream MyEnterprise as the stream used for synchronization
of the Endevor production stage.

•

It is required to define a gated stream as a child of a dynamic stream, if you want to synchronize
the content of this stream from AccuRev to Endevor. No gated streams are used if you want to
synchronize files from Endevor to AccuRev.

To define a stream, select an existing stream and use File > New > Stream. Don't forget to select the
Stream Type Gated Stream where required.

AccuRev Server Configuration
The following steps have to be execute on the machine where the AccuRev server is installed.
1. Stop the AccuRev Server and AccuRev Tomcat. The user interface for starting and stopping the
services varies by platform: • : • :
UNIX/Linux

The acserverctl command-line utility.

Windows

The Services control panel.

You will find details in the AccuRev Administraor’s Guide .
2. It is required to define the AccuRev synchronization user in the AccuRev server's configuration file. To
do this, edit the acserver.cnf file and add a CC_USER line referencing the defined AccuRev user
which should be used to support the synchronization process. You will find this configuration file in the
bin directory of the AccuRev installation path, by default C:\Program Files\AccuRev\bin. A
sample entry looks like this one:
# Enterprise Sync User
CC_USER = syncuser
Important: The CC_USER and the user configured later during the Enterprise Sync configuration in
the AccuRev data source must be the same.
Then save and close this file.
3. In addition it's required to make the AccuRev WebUI available through Enterprise Developer. Create a
settings file settings.xml in the config directory where the AccuRev database is installed, by default
in: C:\Program Files\AccuRev\storage\site_slice\dispatch\config.
Add the following content to the file:
<settings>
<webui url="http://###.#.#.#:####/accurev"/>
</settings>
Note: Replace the numbers with the IP Address of the AccuRev server followed by the AccuRev
Tomcat server's port number. The default port number is 8080.
4. Restart the AccuRev server and AccuRev Tomcat.
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Installing the AccuRev Triggers
Enterprise Sync includes two Perl AccuRev server triggers: one must be installed and the other is
recommended to be installed. You will find more details about AccuRev triggers and also how to install the
triggers on Unix/Linux in the AccuRev Administrator's guide.
The following pages explain how to install the Perl scripts in AccuRev on a Windows server environment.
The AccuRev server and the Enterprise Sync server must be installed before installing and customizing the
triggers, but configuring the Enterprise Sync server is not a pre-requisite for this step.
Before starting with this step make sure that Perl is installed on the AccuRev server machine. If running on
a Windows server also make sure that a Perl utility is available (e.g. PL2BAT) which is required to create an
executable Perl script.

General Preparation before Customizing and Installing the Triggers
Do the following steps on the machine where the AccuRev server is installed:
1. Create a new Windows folder C:\users\triggeruser.
You have to use the AccuRev user name which you have created in the section "Define AccuRev User".
Here we are using the name triggeruser.
2. Open a Windows command prompt as Administrator, and enter the following commands:
set HOMEDRIVE=c:
set HOMEPATH=\users\triggeruser
accurev login -n triggeruser triggeruser
3. Verify that a session token has been created in the .accurev folder.
4. Make sure that a temporary directory is the current one (e.g. C:\temp) and then execute the java
command
java -DLOG_HOME=c:\temp -cp “C:\Program Files\AccuRev\bin\mfcTriggers-2.2.0all.jar” com.microfocus.main.Main --command getTriggers
5. Open the temporary path and verify that two Perl scripts have been extracted to this folder.

Installing the Trigger Supporting the On Demand Sync
The trigger server_master_trig.pl contains a sample which triggers the on demand synchronization
process if a user promotes files to a gated stream and the target stream is configured for synchronization
from AccuRev to Endevor. It's required to install this trigger, otherwise it is neither possible to synchronize
files from AccuRev to Endevor with the mainframe authorization of the promote user nor an on demand
synchronization process is supported when promoting to the gated stream.
1. Edit the file server_master_trig.pl in the temporary folder, navigate to Windows
configuration and make the following customizations:
a) Verify and, if necessary customize the path to the AccuRev executable:
$::AccuRev = "C:\\progra~1\\accurev\\bin\\accurev.exe";
b) Verify and, if necessary customize the homepath, which must point to the previously defined
triggeruser folder.
c) If you have changed the default authenticator credentials which are installed with Enterprise Sync,
then you have to customize the login user and password for Enterprise Sync.
d) Verify and, if necessary customize the directory where the trigger logs will be created. We
recommend using the existing site_slice\logs directory in the path where the AccuRev
database is installed, therefore by installation default:
my $triggerLogDirectory = "C:\\progra~1\\AccuRev\\storage\\site_slice\
\logs";
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e) Verify and, if necessary customize the location where the trigger jar file is located, by installation
default:
my $triggerJar = "C:\\progra~1\\accurev\\bin\\mfcTriggers-2.2.0-all.jar";
Note: You have to use Windows short names, if a folder contains spaces. Verify the names
using DIR /X on the command prompt.
2. Save the Perl script and copy this trigger from the temporary folder to the site_slice\triggers , by
installation default: C:\Program Files\AccuRev\storage\site_slice\triggers.
Create the triggers folder first, if it doesn't exist.
3. Enter the following commands in the command window:
cd C:\Progra Files\AccuRev\storage\site_slice\triggers
pl2bat server_master_trig.pl
perl -wc server_master_trig.pl
Note: The last command verifies that the syntax of the Perl script. You should receive the
message server_master_trig.pl syntax OK.
4. Verify that a bat file server_master_trig.bat has been generated in the triggers folder.
Note: The existence of the bat file is sufficient to activate this master trigger. You would have to
change the file name (not the suffix!) if you want to deactivate this trigger.

Installing the Trigger for Defunct Deactivation and Read-Only Type
Support
The trigger server_preop_trig.pl contains two samples which are deactivating the AccuRev Defunct
function and disallowing the Keep Function for files associated to Endevor Types which are defined as
read-only.
Note: Endevor doesn't support an equivalent function for the AccuRev Defunct command. Therefore a
Defunct cannot be synchronized to Endevor. Therefore we strongly recommend deactivating Defunct
in Depots which are connected to Endevor.
If you are using text files in Endevor which a developer should not update, then Enterprise Sync
allows you configures such rules. For example you want to synchronize generated DB2 DCLGEN files
to AccuRev, but do not want to allow updates to these generated sources. This trigger verify those
configured rules and rejects the Keep command for corresponding read-only files.
1. Edit the file server_preop_trig.pl in the temporary folder and make the following customizations:
•

Verify, and if necessary, customize the path to the AccuRev executable:

•

$::AccuRev = "C:\\PROGRA~1\\accurev\\bin\\accurev.exe";
Customize the homepath to the defined triggeruser folder:
# Windows Example
$ENV{'HOMEDRIVE'} = "c:";
$ENV{'HOMEPATH'} = "\\Users\\triggeruser";
Note: You have to use Windows short names, if a folder contains spaces. Verify the names using
DIR /X on the command prompt.

2. Save the Perl script and copy this trigger from the temporary folder to the triggers folder under the depot
folder. For our sample depot this would be by installation default the path: C:\Program Files
\AccuRev\storage\depots\MyEnterprise\triggers Create the triggers folder first, if it doesn't
exist.
3. Enter the following commands in the command window
cd C:\Program Files\AccuRev\storage\depots\MyEnterprise\triggers
pl2bat server_preop_trig.pl
perl -wc server_preop_trig.pl
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Note: The last command verifies that the syntax of the Perl script. You should receive the
message server_master_trig.pl syntax OK.
4. Verify that a bat file server_preop_trig.bat has been generated in the triggers folder.
Note: The existence of the bat file is sufficient to activate this master trigger. You would have to
change the file name (not the suffix!) if you want to deactivate this trigger.

Enterprise Sync Server Configuration
This chapter describes how to start the Enterprise Sync configuration user interface (Micro Focus
Connect), and it provides an overview of the dashboard and how it is used to configure data sources and
connections, and how to run and manage synchronizations.

Starting the UI
Before starting the user interface, the Enterprise Sync server and the Enterprise Sync Web Service must
be running. See Enterprise Sync Server Installation for more information.
1. Navigate to: http://<machine name>:<port>/ConnectWeb. The default port is 8081. The login
page appears.
2. For the first login use the Default Authenticator user Administrator with password
Administrator.
Note: User name and password are case sensitive.
After accessing the configuration dialog once with these credentials, you will define an AccuRev
Authenticator within the next configurations steps which allows using your AccuRev credentials the next
time instead of the Default Authenticator.
3. Click the Log Out button to log out.

The Dashboard
The main page is referred to as the Dashboard. The dashboard consists of four main pages that are
accessed via tabs:
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Connections

Displays a list of your configured connections and a summary of their synchronization
attributes: the connection's data source, the direction in which assets are synchronized,
the last time a synchronization was run, the last time a synchronization succeeded, and
the current status. The Connection Details panel shows detailed information about the
currently selected connection. You can use this page to edit and create new
connections, which requires that you have created the corresponding data sources first.

Data Sources

Displays a list of currently defined data sources. An Update Data Source Property
Values panel shows detailed information for the currently selected data source. The
information displayed on this panel varies based on the data source. You can directly
change and save values on this update page. Also use this page to create new data
sources.

User Maps

User maps define users that have different user names across multiple data sources.
For example, a user may be User1 in one data source and UserA in another. User
maps allow you to map these two users together so that the system knows they are the
same user.

Authenticators Authenticators are used to enforce which product's users are allowed to log in. A default
authenticator is installed with the following credentials: user (Administrator) ,
password (Administrator). Both, user and password are case sensitive.
Dashboard Toolbar
The dashboard toolbar contains the following icons:
•
•
•

Log out - Logging out has no effect on the status of Enterprise Sync server.
Settings - Display the Settings dialog box, from which you can configure general system settings such
as resources and error notification.
Help - Get help for the Enterprise Sync server, either by displaying the Using Micro Focus Connect
guide, or accessing the Micro Focus Connect community

Setting Synchronization Frequency
1. Click Actions (

) and then select Settings. The Global Settings screen appears.

2. In the Sync Settings group, enter 30 to specify the time in minutes, between synchronizations. The
default is 30 minutes.
3. Click Save.
Note: The system may support on-demand synchronizations. For configured on-demand
synchronization rules, the frequency value defined here has no meaning.

Setting Up Error Notification
You can generate email messages when system and synchronization errors occur. You specify default
values for settings that are used by both types of errors on the Error Notification tab of the Settings
dialog box. You will specify your SMTP server settings, who you want to receive error notification emails,
and how often. If you want, you can override email settings on an individual connection basis as described
in Creating a Connection.
1. Click Actions (

) and then select Settings. The Global Settings screen appears.

2. In the SMTP Configuration and Email Settings groups, complete the fields as described below.
SMTP
Configuration

Email Settings

Use these fields to specify information needed to identify and connect to your
SMTP server.
Host

The email system's host name.

Port

The email system's port number.

Login Name

The email user

Password

The password for the email user.

From Address

The email address from which notification emails will be sent.

Use these fields to specify email recipients and how often you want to send error
notification email.
Send Email To Email addresses for the users you want to receive error
notification email. Separate addresses with a semicolon ;.
Frequency

The frequency with which you want the system to send error
notification email. The default is 60 minutes.
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Data Sources
The topics in this section describe how to use the dashboard to:
•
•
•
•

Create a data source.
Enter the data source connection details.
How to define an AccuRev specific data source.
How to define an Endevor specific data source.

Defining a Data Source
1. On the dashboard, click the Data Sources tab.
2. Above the Data Sources list, click Create New Data Source.
3. On the dialog box that opens, complete the Name and Product fields:
New Data Source Name Enter a unique name for your data source.
Data Source Product

The products that are available in the list are the connectors provided by
Enterprise Sync.

4. Click Add Data Source. Your data source is added to the list of data sources. Select it to edit it. The
data source pane is refreshed with additional fields that are specific to that product. Refer to the next
chapters for defining the data sources of the supported products.
5. After editing the data source fields click Save Changes.
Note: The bottom pane already displays a Type with the name ChangeSet. There is no need for
making any changes within this pane.

AccuRev Data Source Fields
Before defining the AccuRev data source, make sure that AccuRev is installed and configured.
Then, define a new data source for AccuRev using the Create New Data Source button with a unique
name (for example AccuRevDS) and by selecting the product AccuRev from the list of the supported
products.
Enter the following values on the Update Data Source Property Values pane and don't forget to save the
changes after entering the values. Saving the changes will already verify some values entered on the pane
and will also verify the connection to the AccuRev server.
Note: After saving the AccuRev data source Micro Focus strongly recommends to define an AccuRev
Authenticator for this data source. This authenticator is required to support the on demand
synchronization process from AccuRev and in addition an AccuRev user can be used for accessing
the Enterprise Sync configuration user interface next time instead of using the default authenticator.
AccuRev Port

The AccuRev server's port, by installation default 5050.

AccuRev Server

The AccuRev's server address

Change Package If AccuRev issue tracking is used and Enterprise Sync is configured to synchronize
CCID Field Name issues between two data sources, then this is a property that must exist on AccuRev
issues. The default value is ccid . If this property does not exist in the AccuRev
schema, it will be automatically added. If an AccuRev schema does not exist in the
AccuRev Depot, then a default one will be installed automatically, if required.
Change Package
Stream-Name
Field Name
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This contains the entry stream when synchronizing from Endevor to AccuRev with
Change Package support. For more information, see Change Package Support.

The AccuRev depot which is source or target of a synchronization connection which
uses this data source.

Depot Name

Note: If you want to support different AccuRev depots, then you have to define
one AccuRev data source for each depot.
This is a colon separated string that does pattern matching against files and can be
used to exclude files from sync operations. If you add a directory named source in
AccuRev and you don't want it to sync, the exclude list would include source. If there
was a specific file in directory docs you don't want it to sync, for example, docs
\readme.txt you would include that in the string. So multiples would look like:
source:docs\readme.txt:bin

Exclude List

This would exclude elements at the root of your AccuRev streams and workspaces
source, bin and the file docs\readme.txt.
Full Path to
AccuRev
Executables

If AccuRev is not installed separately on this machine, you will find the path to the
AccuRev executable in a sub directory of the Enterprise Sync installation path, by
installation default here: C:\Program Files\Micro Focus\Enterprise Sync
\connectors\accurev\accurev.

Password

The AccuRev password for the user defined below.

Retrieve
Changes Using
Change Package

This is only relevant for synchronizations to AccuRev and only applies when a CCID
value is provided from changes during synchronizations to AccuRev. If true, a
synchronized file will be associated to all AccuRev Issues having the specified CCID
value (see Change Package Field Name above). If no Issue exists with the specified
CCID value, a new Issue will be generated, with the specified CCID value, and the
file will be associated to the new Issue. If false , file changes are synchronized to
AccuRev, but not associated to an Issue, even if an AccuRev Issue with the specified
CCID value exists.

Store Changes
Using Change
Package

This is only relevant for synchronizations from AccuRev and only applies when the
CCID field is associated to the AccuRev schema and a user selects at least one
AccuRev issue which has a CCID value associated when promoting files. If true , a
synchronized file from AccuRev will provide the target system with the first issue's
CCID (see Change Package Field Name above).

Time OffSet

You can leave this blank.

User Name

This AccuRev user name is used by Enterprise Sync as the login user. This user
name must match the CC_USER name required in the AccuRev server's configuration
file (see Modify the acserver.cnf File .)

Endevor Data Source Fields
Before defining the Endevor data source, make sure that Mainframe Access server is installed and
configured for accessing the corresponding Endevor instance.
Then define a new data source for Endevor using the Create New Data Source button with a unique name
(for example EndevorDS) and by selecting the product Endevor from the list of the supported products.
Enter following values on the Update Data Source Property Values pane:
Code Page
File

Pointing to this optional file supports specific mainframe code pages on an Endevor
element type level. This is only required if the session code page defined below does not
apply to all Endevor element types. If the element type name is mapped in the referenced
properties file, then the code page value from the file will override the default session
value. If the element type name is not mapped in the properties file, then the session code
page value will be used.
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The format of the file is: "Endevor element type name"="Code page value"
You can use any code page value which is supported as session code page value (see list
below). In addition following code page values are supported only for Endevor element
types, but not as a session code page:
x-IBM1380
x-IBM300
x-IBM834
x-IBM835
x-IBM837
x-IBM927
x-IBM947
x-IBM951
Example: assuming the German code page IBM01141 is defined as the session code
page, but should not be used for C files. Then create a code page file with the following
entry: C=IBM01140.
The field entry in the data source points to this file, for example: C:\EnterpriseSync
\config\codepage.txt
Extensions
File

Connect queries Endevor and provides default extension sets within Endevor. If you need
additional extensions, or changes to the extensions, then you would use the file
extensions file to include these settings. For example if you want Endevor files to use a
setting not immediately provided by Endevor, you could create the file extensions file with
an assembler entry.
The format of this file is: "Endevor element type name"="file extension value"
If you are configuring this extension file, then Enterprise Sync will only use the values
specified in this file and not use the values defined in Endevor. Enterprise Sync will use
the values from Endevor only if this file doesn't exist. No file extension is created during
the synchronization process, if it is not defined for a specific type.
Examples:
COBOL=cbl
PLI=pli
INCLUDE=inc
COPY=cpy
EXE=bin
MACRO=mac
ASM=asm
BMS=bms
JCL=jcl
JCLPROC=jcl
LINKCARD=txt
PARM=txt
LOAD=txt
The field entry in the data source points to this file, for example: C:\EnterpriseSync
\config\fileext.txt.

Include
SubSystem
in Path
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The standard path (folder structure) created by Enterprise Sync when synchronizing
Endevor elements to path structured target system would include the three folder levels
Endevor System, Subsystem and Type. Select True if you want to include Endevor

subsystem names in the synchronization path. Normally you would select False if an
Endevor system has exactly one subsystem, and the subsystem name is not relevant in
this context. You can override the path mapping rule specified here using the Logical
Path Value Mapping file (see below).
Logical Path This path value mapping is only required if the default path containing the Endevor
System, (Subsystem) and Type is not sufficient. In this referenced file you can map any
Value
Mapping File combination of Endevor environment/system/subsystem to any folder structure (path). The
usage of a specific path mapping file may be required if Endevor is configured in a way
that system or subsystem names are changing when moving elements from one stage to
another. With this path mapping you can assure a stable path structure.
Examples:
SMPLPROD.ESNCTST.BANKDEMO=esnctst\bankdemo
SMPLTEST.ESNCTST1.BANKDEMO=esnctst\bankdemo
SMPLTEST.ESNCTST2.BANKDEMO=esnctst\bankdemo
The field entry in the data source points to this file, for example: C:\EnterpriseSync
\config\pathmap.txt.
Mainframe
Node

This is the node to your mainframe system accessible via TCP/IP. It could be a TCP/IP
address or a logical name, but it should be the same name which is used in Micro Focus
Enterprise Developer for accessing the mainframe. If both names are not identical, it is
possible that the mainframe credentials dialog pops up twice per session within Enterprise
Developer.

Mainframe
Port

This is the Mainframe Access Server port.

Mainframe
Server

This field must contain a unique server name for this mainframe connection (any unique
value).

Password

The password for the mainframe user defined below.
Note: We recommend using an administrator mainframe user with a password
which does not expire.

Read Only
Element
Types

If you want to synchronize Endevor elements, but you do not want to allow updates to
these files in the synchronized target system, then specify the corresponding Endevor
element types in this field separated by comma. Example: Assuming the Endevor element
type DCLGEN would contain generated Cobol copybooks, then you would enter DCLGEN
into this configuration field.

Session
Code Page

If a session code page is not specified, then the installation default from the Mainframe
Access Server is used. Following code pages are supported.
IBM01140
IBM01141
IBM01142
IBM01143
IBM01144
IBM01145
IBM01146
IBM01147
IBM01148
IBM01149
IBM037
IBM1026
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IBM1047
IBM273
IBM277
IBM278
IBM280
IBM284
IBM285
IBM297
IBM500
IBM870
IBM871
The standard data translation between the mainframe and the Enterprise Sync server is
based on this code page. This includes the file translation, as long as the Endevor
element type doesn't have the binary attribute associated and as long as not another code
page is configured for a specific Endevor type in the Code Page file (see above).
Time OffSet

You can leave this blank.

User Name

This Mainframe user name is used by Enterprise Sync as the login user to the Mainframe
Access Server and for accessing Endevor. The mainframe user is mainly used for
supporting a time interval based synchronization process or for retrieving general
information from the Endevor instance. Enterprise Sync also supports the synchronization
to Endevor on demand triggered from the IDE, for example from Enterprise Developer. An
on demand synchronization uses the mainframe credentials of the mainframe user
working in the IDE and not the mainframe credentials specified here in the data source.

Defining an Authenticator
Authenticators are used to enforce which product's users are allowed to log in and edit configurations. A
default authenticator is installed with the following user name (Administrator) and password
(Administrator). Both, user name and password are case sensitive.
To define an Authenticator:
1. On the dashboard, click the Authenticators tab.
2. Above the Configured Authenticators list, click Add Authentication Provider.
3. On the dialog box that opens, select valid values on the Product and Data Source fields and then click
OK.
Defining the AccuRev Authenticator
Note: This is a required step before using the on-demand synchronization support in AccuRev.
Before defining this authenticator, you have to create an AccuRev data source first. Then, add a new
Enterprise Sync authentication provider by selecting the product AccuRev and the AccuRev data source.
Refresh the dashboard and verify that you can access the Enterprise Sync configuration user interface with
your AccuRev credentials.
Defining the Endevor Authenticator
Before defining this authenticator you have to create an Endevor data source first. Then add a new
Enterprise Sync authentication provider by selecting the product Endevor and the Endevor data source.
Refresh the dashboard and verify that you can access the Enterprise Sync configuration user interface with
your mainframe credentials.
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Creating User Maps
User Maps define users that have different user names across multiple data sources. For example, a user
may be UserA in one data source and UserB in another. User maps allow you to map these two users
together so that the system knows they are the same user. Use the following section to learn how to create
a user map.
1.
2.
3.
4.
5.
6.
7.
8.

On the dashboard, click the User Maps tab.
Click Add User Map. A row is added to the list.
Double click on the User Map text in the Name field.
Rename the user map. This value is only used in Micro Focus Connect and can be whatever you want it
to be.
In the user map row, click on the Add User button. A new user name row is added as a child to the user
map.
In the Data Source column, double click the new row to enable the list. Select the proper data source
for the user.
Double click the User Name text in the Name field and type in the user name as it exists in that data
source.
Follow the same steps to add additional users to the user map.

Mapping Mainframe Users with AccuRev Users
Before synchronizing mainframe files with AccuRev, you should define user maps for all mainframe users
changing files on the mainframe to the corresponding AccuRev user (see the chapter on how to define the
AccuRev user).
Based on these defined user maps, the system enables AccuRev to provide the information about who has
done the latest changes when a file is synchronized from the mainframe. With this, the AccuRev history
support will provide the user for all managed versions with the information who has changed specific
records within a file (see AccuRev Annotate function).
Note: The AccuRev supported on demand synchronization process requires a defined user map for
the AccuRev and mainframe user who is triggering the on demand synchronization. This user map is
generated automatically during the on demand synchronization, if it doesn't exist.
Important: Do not define conflicting user mappings, for example one user map for the mainframe
UserA mapped to the AccuRev UserB and another user map for the same mainframe UserA
mapped to the AccuRev UserC .
In case you have to create a lot of user mappings you may want to create a script which generates the
Enterprise Sync user mappings. To do this create a script which generates an XML file with a format like in
the following sample:
<UserMaps>
<UserMap>
<name>User Map for usera</name>
<User>
<type>DataSource</type>
<value>AccuRevDS</value>
<name>usera</name>
</User>
<User>
<type>DataSource</type>
<value>EndevorDS</value>
<name>USERB</name>
</User>
</UserMap>
<UserMap>
...
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</UserMap>
...
</UserMaps>
For activating these generated user map definitions execute the following steps:
1. Disable any running connections.
2. Logout from the dashboard.
3. Create a manual backup of the system's configuration XML file Connect.xml, located here: C:
\Users\<winuser>\AppData\Local\Micro Focus\Enterprise Sync\Connect.xml.
4. Copy the generated XML into the Connect.xml file before the <Authenticators> entry. If the
<UserMaps> entries already exist, integrate your generated XML into the existing definitions as
required.
5. Login to the system and verify that the User Maps tab displays all your generated user mappings
correctly.

Working with Connections
A Connection represents the relationship between two data sources. You use the connection to:
•
•
•

Identify the data source whose assets you plan to synchronize.
Specify the projects you want to synchronize.
Start/stop the synchronization process.

Creating and Editing Connections
You perform these tasks using the Create Connection Wizard.
Note: The data sources you want to use for a connection must exist before you can complete a
connection. See Defining a Data Source for more information.
1. From the Connections tab, click the Add Connection button. The Create Connection Wizard
appears.
2. On the Data Source tab, enter a name in the Connection Name field.
3. n the Master Name field, select a data source to use as the master data source. Define this data
source as the master which should win in case of conflict situations. In case of parallel file changes
done in both data sources Enterprise Sync will assure that the file in the master data source is not
replaced with the version coming from the other data source.
4. In the Target Name field, select a data source to use as the data source which is used for
synchronizing data from and to the master data source.
5. Optionally, use the fields in the Error Notification group to override error notification email settings
specified in Settings
•
•

Enter email addresses (separated by a semicolon (;)) in the Send Email To field.
Change the value in the Frequency field.
Tip: Email addresses and frequency values established on the Settings page are not displayed
here.

6. Click the Next button which displays the Types and Fields tab. The current version of Enterprise Sync
doesn't support any specific mappings on this page. A Type Mapping called ChangeSet is already preconfigured. Do not change this and do not add a new Type Mapping.
You may want to select the Default Sync Direction. This is a default value only and can be
changed on a project level later on. The three values have the following meaning:
•
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A bi-directional synchronization supports data transfers in both directions, from and to the master
data source.

•

As an alternative you may want to synchronize only in one direction, either from the master to the
target data source or vice versa.
7. Click the Next button again which displays the Projects tab. A Project defines a specific synchronization
rule for the previously selected data sources. You can defines several projects within one connection
and each single project can be activated for synchronization separately.
8. Click the Add button. A new row is added to the list.
9. Select the project you want to map from the Target list.
Tip: The data source product name is displayed on the list column title. The values displayed on
the list depend on the product associated with the data source.
Note: Depending on the selected data source multi selection may be allowed or disallowed.
10.Select the corresponding Master project from the Master Project list. Depending on the selected data
source multi selection may be allowed or disallowed.
11.The direction is pre-defined corresponding to the default value selected on the Types and Fields tab
(inherit). You can select and associate another valid direction for this project, either From Master, To
Master or Bi-directional.
12.Project synchronizations are enabled by default. If you wish to disable it, clear the check box.
13.Some data sources for SCM tools allow you to specify a deeper directory level synchronization. If it's
available and you want to specify a directory deeper than the root directory for synchronization, click the
project path button and enter path in the fields provided.
14.Once you have added all projects you want to synchronize, click the Save button to save your changes.
Once a connection defined and saved, you can use the Connections tab on the dashboard for editing the
connection's configuration data. Select one connection and click on the edit button to open the connection
wizard again. We strongly recommend that you disable a connection first before editing it.
If you are changing configuration data which have an impact on the synchronization process, but some
synchronization have already been executed, then it might be required to verify all executed
synchronizations and, if required, execute the synchronization again based on the changed configuration
data. It depends on the data sources which configuration changes are allowed and supported.
It might be required to run the synchronization once again on all files. This can be enforced by clearing the
connection's synchronization watermarks . If you click on this button you have to confirm that you really
want to delete the water marks.
Important: Clearing the water marks might have a significant impact on the next synchronization
runtime, because the synchronization is checked and, if required, executed once again for all files.

Displaying Connection Information
Once a connection is defined, use the Connections tab on the dashboard to display the connection
details. After selecting one connection, there are several tabs available on the bottom part which displays
information about the connection's configuration and about the synchronization status.
1. The Projects tab displays a list with all defined projects. The Enabled column shows whether a specific
project is currently enabled for synchronization.
2. The High Water Marks tab displays for each defined project the current synchronization status.

Importing Project Definitions
Depending on the product, some connections may require creating many projects. Importing the project
definitions from an external XML file is supported for this. The import XML file has to be created like in
following sample:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ProjectMapping xmlns=" http://www.example.org/ConnectConfig2 ">
<ProjectMaps>
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<ProjectMap>
<source>source project value 1</source>
<target>target project value 1</target>
<enabled>true/false</enabled>
<direction>fromSource/fromTarget/both</direction>
</ProjectMap>
<ProjectMap>
<source>source project value 2</source>
<target>target project value 2</target>
<enabled>true/false</enabled>
</ProjectMap>
<ProjectMap>
...
</ProjectMap>
...
</ProjectMaps>
</ProjectMapping>
•
•

Source/target depend on which product is the master (source) for the synchronization process and
which is target.
Enabled determines whether or not that particular project map entry is active.

If multi selection is supported for source or target, then use the comma , for separating the values.
Direction is an optional parameter. If not used the value is inherited from the connection definition. Valid
values are:
•
•
•

fromSource
fromTarget
both

Project Map File Includes/Excludes
By default, when a project is mapped, all files are included in the synchronization. In cases where you only
want certain directories or file types, you can explicitly include/exclude any file type/directory from a
synchronization for a project map.
For example, if an include directory is TEST/BANKDEMO, then all files contained in that directory only will be
synchronized.
Similarly, if an include directory is TEST/BANKDEMO and the exclude directory is TEST/BANKDEMO/ACCTS,
then all files in TEST/BANKDEMO will be synchronized except for the files in TEST/BANKDEMO/ACCTS.
You can also restrict the files to be synchronized by specifying file-extensions to be included and excluded.
Use the Include or Exclude icons on the Selected Projects lists:
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For the highlighted columns above:
•
•

The first column contains the Includes files/directories

.

The second column contains the Excludes files/directories

.

Click one of the icons to either add or edit an Includes or Excludes for a directory or an extension.
When values have been set for the project map, the icon is blue.
Path/Extension Includes Dialog box

Path
Includes

•
•
•

Specify a list of path inclusions. Example: TEST/BANKDEMO/ACCTS.
The initial starting values come from the connectors themselves (both sides of the
project map).
Items can be checked or unchecked (only checked saved to XML file).
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Extension
Includes

•

Double-click to edit or click Add to add a new row.

•
•

Specify a list of file extension inclusions. Example: EXE, CBL, …
The initial starting values come from the connectors themselves (both sides of the
project map).
Items can be checked or unchecked (only checked saved to XML file).
Double-click to edit or click Add to add a new row.

•
•

Path/Extension Excludes Dialog Box
Path
Excludes

•
•
•
•

Extension
Excludes

•
•
•
•

Specify a list of path exclusions. Example: TEST/BANKDEMO/ACCTS.
The initial starting values come from the connectors themselves (both sides of the
project map).
Items can be checked or unchecked (only checked saved to XML file).
Double-click to edit or click Add to add a new row.
Specify a list of file extension inclusions. Example: EXE, CBL, …
The initial starting values come from the connectors themselves (both sides of the
project map).
Items can be checked or unchecked (only checked saved to XML file).
Double-click to edit or click Add to add a new row.

Starting and Stopping Connections
A connection needs to be fully defined before you can start it. You can see a connection's status on the
dashboard.
To start a connection, click its Start button

on the dashboard.

To stop a connection, click its Stop button

on the dashboard.

Connection Status Values
The Connections page contains a grid listing each of your connections. One of the columns in the grid is
Status. The following are the available values:

40

| Administration

Disabled

This status is displayed if you have stopped successfully the connection or you have
defined and not started a new connection. In this status, the synchronization process is
not running.

Failed

One or more projects associated with this synchronization have failed and no
subsequent iterations have succeeded. See the Running status for an example.

Idle

There are no projects to synchronize or the project maps are disabled.

Restarting

The application is re-reading the configuration file and is restarting all of the
synchronizations. When the sync is complete, the status will change to Running or
Failed. If you are starting a synchronization which was in disabled mode, then the
status changes to Restarting first. But there may be also occasions where a running
process restarts automatically.

Running

The status will be Running when the last available status for all projects is Success .

Example: A synchronization has projects (p1, p2, p3):
Case 1 RUNNING:
Iteration 2: p1=success, p2=success, p3=success
Iteration 3: p1=ongoing
Case 2 FAILED
Iteration 2: p1=failed, p2=success, p3=success
Iteration 3: p1=ongoing
Case 3 RUNNING:
Iteration 2: p1=failed, p2=success, p3=success
Iteration 3: p1=success, p2=ongoing
Server
Reinitializing

The application is reinitializing after changes to the configuration file. This status will
display for all connections until the application has re-read the configuration file and
created the associated projects.

Unknown

The synchronization status is not known to the application. There is an error.

Specific Considerations when Defining AccuRev to Endevor
Connections
Enter the prerequisites here (optional).
The following rules apply when defining connections based on an AccuRev and an Endevor data source:
1. The Enterprise Sync server needs access to the AccuRev server and to the Mainframe Access Server
when defining the connection.
2. Endevor must be master in such a connection, the current release of Enterprise Sync does not support
defining AccuRev as the master.
3. Before defining projects, you have to create all required streams in AccuRev first because the project list
requires the selection of exactly one stream as a project value. Multi selection of AccuRev streams is
not supported when defining one project.
Tip: The list displays all streams defined in AccuRev, but based on the implementation design you
would normally select a dynamic stream as the target for a synchronization process with Endevor.
Do not select a gated stream as the target. Although an AccuRev user may promote files to a
gated stream, and by doing this triggering an on demand synchronization process, it is correct to
define the corresponding project mapping with the parent dynamic stream.
4. The selection list for an Endevor project displays all combinations of Endevor environments, stages,
systems and subsystems for selection. Endevor subsystems are only displayed on this list, if the
Endevor data source attribute Include Subsystem in Path is selected as true. Multi selection is
supported. This allows mapping several Endevor systems and subsystems to one AccuRev stream.
Note: For mapping several Endevor systems/subsystems to one stream, define only one project as
described above instead of defining several projects with the same AccuRev stream.
Changing the Configuration and Clearing Watermarks
Clearing the watermarks might have a significant impact on the next synchronization runtime, because the
synchronization is checked and, if required, executed once again for all files. If the file content is identical in
Endevor and AccuRev, then no new element revision is created in AccuRev during the next
synchronization iteration. If metadata has changed then these metadata are synchronized to AccuRev,
even if the file content has not changed.
Some configuration changes may have an impact on the file content, on the path or on the metadata stored
in AccuRev.
As a general rule Enterprise Sync will only interpret the changed configuration fields for new synchronized
files, which means that you have to clear the watermarks to assure that a configuration change has an
impact on all already synchronized files.
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Endevor Data Source
Configuration
Change

Description

Session code page
changed

Clear the watermarks to assure that all files with different content caused by the
code page change are synchronized correctly to AccuRev.

Code page file
changed

Clear the watermarks to assure that all files with different content caused by the
code page change are synchronized correctly to AccuRev.
As an alternative purge the corresponding folders, because only specific Endevor
Types are affected by this change. Enterprise Sync will recreate the folders with
the latest Endevor version, but the AccuRev history is not available anymore when
using this alternative.

Extension file
changes

It's recommended to clear the watermarks to assure that all AccuRev elements
with an old file extension are recreated and the corresponding metadata are
updated correctly.
Note: Synchronized AccuRev elements with old extensions are purged after
restarting the synchronization process.
The elements with old extensions are even purged if you don't clear the
watermarks, because Enterprise Sync will purge all AccuRev files which are
not mapped to Endevor elements.

Include subsystem
in path

You should avoid changing this field value because Enterprise Sync would purge
the complete stream content and recreate the elements in the new path, even if
you don't clear the watermarks.

Local path value
mapping file

You should avoid changing existing entries in this file because Enterprise Sync
would purge the corresponding stream content and recreate the elements in the
new paths, even if you don't clear the watermarks.
Of course it is never an issue to add additional mappings to this file, for example
after defining new connection projects.

Mainframe node,
port and server
name

You can change these values as long as the mainframe connection points to the
same Endevor repository. This change does not have an impact on synchronized
AccuRev elements.
There are some AccuRev stream properties containing these values which are
updated automatically by Enterprise Sync.
It is not necessary to clear the watermarks.

Mainframe userid
and password

You can change these values. It does not have an impact on synchronized
AccuRev elements.

Read-only element
types

If you change the list of the read-only element types this has a direct impact on
new synchronized AccuRev elements. To assure that all already synchronized files
have the correct read-only flag associated you will have to clear the watermarks.

AccuRev Data Source
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Configuration
Change

Description

Depot name

Clear the watermarks to assure that a new clean initial synchronization is done
into the new depot.

Configuration
Change

Description
The depot has to be prepared to support the connection project targets (streams).

AccuRev server and As long as the new connection points to the same AccuRev database, this
port
change does not have an impact on synchronized AccuRev elements. There are
some AccuRev stream properties containing these values which are updated
automatically by Enterprise Sync. It is not necessary to clear the watermarks.
If the connection points to a new AccuRev database clear the watermarks to
assure that a new clean initial synchronization is done into the new database. The
depot has to be prepared to support the connection project targets (streams).
Exclude list

If you delete entries from the exclude list, but these entries are pointing to existing
paths in AccuRev which are not mapped to logical paths in Endevor, then
Enterprise Sync would purge the corresponding folders and files.
It is not necessary to clear the watermarks.

All Change Package
related fields

You can change these values. Such a change does not have an impact on
already synchronized AccuRev elements, it only has an impact on the future
Change Package processing.
It is not necessary to clear the watermarks.

Full path to AccuRev You can change this value, if required. It does not have an impact on
synchronized AccuRev elements.
executables
AccuRev user name
and password

You can change these values, but you have to make sure that a new user name is
also updated in the AccuRev server configuration file.
This change does not have an impact on synchronized AccuRev elements.

Connection
Configuration
Change

Description

Deleting, enabling,
disabling a project

This change does not have an impact on already synchronized AccuRev
elements.

Adding a project

Adding and enabling a new project to a connection will be processed in the next
iteration. It is not necessary to clear the watermarks.

Changing a project

You should avoid changing an enabled project with already synchronized
elements. If you still want to change an existing project you have to clear the
watermarks as well before restarting the synchronization process.
Depending on your change this could lead to purged folders in AccuRev.
Instead of changing and project we recommend to delete or disable the project
and to add a new project. By doing this it is not required to clear the watermarks.

Verifying the Installation and Configuration in Enterprise
Developer
Use the following procedure for verifying the installation and configuration process based on a defined
Enterprise Sync connection which synchronizes Endevor elements with AccuRev files. The following must
be installed and configured before continuing this procedure:
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Enterprise Sync

The installation must be complete and configured successfully for the
synchronization process. The synchronization process should be running. See
Enterprise Sync Server Configuration.

Enterprise Developer

The installation must be complete and the AccuRev Eclipse Plugin as well as
the AWM AccuRev Integration Plugin must be installed on top of Enterprise
Developer

Workflow Manager
(AWM) Endevor
Attachment

The installation must be complete and configured successfully.

AccuRev Client

The AccuRev client must be installed on the same machine where the
Enterprise Developer is installed

1. Start Enterprise Developer.
2. On the Workspace Launcher dialog box, enter a workspace name of your choice. Then click OK.
3. If this is the first time you start Enterprise Developer, you are presented with the Eclipse Welcome
page. Click Open Team Developer Perspective to close the Welcome page and open the Team
Developer Perspective.
If the Welcome page is not opened, click Window > Open Perspective > Other, select the Team
Developer (default) and click OK.
4. Click the Remote Systems tab.
5. Create a remote system (mainframe) connection (if a connection to your mainframe has not been preconfigured and is therefore not listed):
a)
.
On the Remote Systems tab, click
b) Select Micro Focus z/Server, then click Next.
c) Enter the details of the mainframe that has z/Server and MFA server installed.
Important: Enter exactly the same host name which has been used when configuring the
Endevor data source on the Enterprise Sync server.
d) Click Next, enter the MFA port number for the installation on the mainframe, and edit the host code
pages, as required, and then click Finish.
Note: It should be the same port and the same session code page which has been used when
configuring the Endevor data source on the Enterprise Sync server.
6. Connect to your mainframe system with your mainframe credentials.
7. The mainframe connection was successful if the background color of the icons is displayed in green.
Verify your Enterprise Developer mainframe installation (Mainframe Access Server and z/Server
installation) and the network connectivity, if the connection cannot be established.
8. The Application Explorer view should display a mainframe system entry after the mainframe connection
has been established. If the system entry is not visible select, Add system(s)… from the context menu
and select the previously created mainframe system. If this mainframe system entry is still not visible,
then verify that the z/Server User server configuration and that the Workflow Manager Endevor
Attachment has been correctly configured.
9. When expanding the mainframe system entry in the Application Explorer view, an application with the
name Enterprise Sync V2.2 Endevor Application should be visible. Select Load Application from
the context menu.
If this application entry is not visible, then verify that the Workflow Manager Endevor Attachment has
been correctly configured and the application has been added correctly to the Workflow Manager's
Master Configuration file.
Note: The application name might be different in your installation.
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10.Expand the Endevor entry a few times until Endevor elements are listed in the tree view. If this doesn't
work, verify that the Workflow Manager Endevor Attachment has been correctly installed and configured
and the z/Server user server has access to the Endevor installation.
11.On the AccuRev Workspace entry select New > Project … from the context menu.
12.In the New Project wizard, select AccuRev>Project from AccuRev and click Next. If this project is not
visible, verify that the AccuRev Eclipse plugin has been correctly installed on top of Enterprise
Developer.
13.Select the AccuRev server address and port (port 5050 is default). Then select the AccuRev depot and
a gated stream which you want to use as a basis for creating an AccuRev workspace. You may have to
login to AccuRev first. Then click Next.
If no depot is visible or no streams are displayed verify the following:
a) Verify that your AccuRev login credentials were correct (logout/login).
b) Verify that an AccuRev depot exists on the server.
c) Verify that the stream structure has been defined in this AccuRev depot including the required gated
streams.
14.Enter the AccuRev Workspace Name. This could be the same name as the parent stream, because
AccuRev will add your user name automatically. Specify a path on your disk outside the Eclipse
workspace (e.g. c:\microfocus\esd\) and then click Next.
15.Enter an Eclipse Project Name and then click Next.
16.Create the workspace in a General Eclipse Project. Then click Next and then Finish to create the
AccuRev workspace in a general Eclipse project.
17.Refresh the workspace entry in the Application Explorer view.
18.Expand the workspace a few times and navigate to a folder where you would expect the synchronized
Endevor elements. Select one COBOL file any verify that the Properties view contains values for the
AccuRev and Endevor properties. This means that the Endevor metadata have been correctly
synchronized to AccuRev.
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If you don't see the folder structure when expanding the stream, verify that the Enterprise Sync server
has been configured correctly and that the initial synchronization has been executed.
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If the properties view doesn't contain AccuRev and Endevor metadata verify that the AWM AccuRev
integration plugin has been installed on top of Enterprise Developer.
19.Verify that the AccuRev WebUI works by selecting Team > WebUI from the context menu.
20.The WebUI window should open. Click on the Stream Browser which should display the stream
structure. If the WebUI window doesn't open verify that the AccuRev server's settings.xml file has
been created correctly and the AccuRev Web Service is running.
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AccuRev Workspace

Private developer work area.

AWM

See Workflow Manager.

CCID

An Endevor short name for Change Control Identifier, which is an attribute
associated to Endevor elements.

Change package

A set of AccuRev elements. The change package records the changes to one or
more elements. Each entry in the change package describes changes to one
element: the changes between the basis version and the head version.

Connection

The configuration that permits synchronization of specific assets. A connection
defines a master and a target data source and several specific mapping rules
defined as projects.

Connector

Software that interacts with an SCM system (CA Endevor, for example) to
perform synchronizations.

Connector type

The name of the third-party repository with which a connector interacts.

Content type

The content type specifies how data are stored in AccuRev or Endevor (for
example binary or text).

Data source

A specific instance of an Enterprise Sync connector.

Depot

Main repository on an AccuRev server for all related source code.

Eclipse Project

AWM applications, Enterprise Developer Cobol or PL/I projects and AccuRev
workspaces are managed in Enterprise Developer in Eclipse projects.

Element type

A type is a category of source code that is used as part of the classification of
an Endevor element. For example, there are types for COBOL, COPYBOOK,
JCL.

Endevor

A short name for CA's Endevor Software Change Manager product.

Enterprise Sync
Project

An Enterprise Sync project is a specific configuration defined in a connection
which defines mapping rules for SCM assets. A connection may define several
projects, for example depending of the stages, application systems, etc.

Environment

An environment is the top level of the logical structure used to classify elements
in Endevor.

Eclipse Workspace

A developer local workspace used by Enterprise Developer to manage Eclipse
project data.

Element

A file or directory that is under version control. This term is used in AccuRev for
files and directories and used in Endevor for files.

Gated stream

A special AccuRev stream which is used by Enterprise Sync to support on
demand synchronizations (see also Stream).

Master data source

The primary and leading data source defined in a connection. In case of a bidirectional synchronization the assets of the master data source are treated with
precedence, for example when a conflict situation occurs.

Processor Group

A processor group identifies a set of processors for a specific element type in
Endevor. A group can include up to three processors (one generate, one delete,
and one move processor, or any combination).

Project

See Enterprise Sync Project or Eclipse Project.

SCM

Software change and configuration management: a third party product
managing software assets relevant for application development. This typically
includes features like versioning, change management, build management and
process management.

Stage

A stage in Endevor is a step in the software life-cycle. There are two stages
defined for each Endevor environment.

Stream

Configuration of related elements in AccuRev. Code may be promoted into or
inherited from streams.

Subsystem

A subsystem is a part of the Endevor classification of an element. Subsystems
are used for specific applications within a system.

Synchronization

The process of mirroring and synchronizing assets (one- or bi-directional)
between two third-party SCM systems (for example between AccuRev and
Endevor).

System

An Endevor system is a way to classify elements in Endevor. A system typically
represents the applications.

Target data source

The second defined data source in a connection, which is not the master data
source.

Type

See Content type or Element type.

Workspace

See AccuRev Workspace or Eclipse Workspace.

Workflow Manager

A feature in Enterprise Developer for Eclipse which generates a user interface
and integrates custom applications, for example the third party SCM systems.

Version

A particular revision of an element in AccuRev. In Endevor the term VVLL
(version/level) is used to identify a revision in an environment.
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Troubleshooting
Use the topics in this section to troubleshoot common issues.

Contacting Micro Focus
Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus
provides worldwide support, delivering timely, reliable service to ensure every customer's business
success.
All customers who are under a maintenance and support contract, as well as prospective customers who
are evaluating products, are eligible for customer support. Our highly trained staff respond to your requests
as quickly and professionally as possible.
Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus
SupportLine to resolve your issues, or email supportline@microfocus.com.
Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access
to other support information. First time users may be required to register to the site.

Creating a Dump File
If reporting a protection violation you might be asked to provide a dump ( .dmp) file. To produce a dump file
you use the Unexpected Error dialog box that is displayed when a protection violation occurs. Unless
requested by Micro Focus SupportLine, leave the dump setting as Normal (recommended), click Dump,
then specify a location and name for the dump file. Once the dump file has been written you can email it to
Micro Focus SupportLine
You may also be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing
infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation
of a number of Micro Focus software components.

Reviewing Log Files
Do the following to locate the log files:
1. Open <install path>\Micro Focus\Enterprise Sync\local.properties.
2. Find the USER_DIRECTORY= entry. It will be something similar to:
c:/users/<winuser>/AppData/Local/Micro Focus/Enterprise Sync
3. Open that directory and you will find a logs directory.
Changing the Logs to Debug Level
If you require more detailed log file information, change the logging level to DEBUG:
1. Find and open for editing the log4j.xml file in the C:\Program Files\Micro Focus
\Enterprise Sync directory.
2. Locate the <logger ... elements. There are many. They each contain a <level> element. One full
entry will look similar to:
<logger name="stderr" additivity="false">
<level value="INFO"/>
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<appender-ref ref="DEFAULT"/>
<appender-ref ref="ERROR"/>
</logger>
3. Change the value="INFO" to value="DEBUG".
4. Save and close the file.
5. Re-start the EnterpriseSyncConnect service.
Note: In addition, there is a rest server log available in <install path>\Micro Focus
\Enterprise Sync\WebServer\webapps\connectRest\logs, which might be required if
issues are related to the Enterprise Sync Web Service interface.

Debugging the AccuRev Eclipse Plugin
1. In Enterprise Developer, select Window > Preferences and navigate to Team > AccuRev. Then check
Enable debug in log.
2. You will find the log information in the User's folder (C:\Users\<winuser>).

Enterprise Developer and AWM Related Logs
1. Ensure that a .options file is available in the Eclipse directory of the Enterprise Developer installation.
The .options file is copied to the Eclipse directory with the product installation. It must contain the
following information:
com.microfocus.awm/debug=true
com.microfocus.awm/debug/flag=true
com.microfocus.awm.mvssystem/debug=true
com.microfocus.zserver.communicator/tracing=true
If the file is not available in the Eclipse directory of Enterprise Developer you can edit it with Notepad or
any similar text editor. To quickly find the Eclipse directory, click Open File Location from the
Enterprise Developer shortcut.
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2. Start the Eclipse workbench with the -debug option (append -debug to the Target field shown above).
3. Reproduce the error and export the error log to a local file (click Error Log View from the Eclipse
workbench).
4. Add the exported file to all the other information (problem description, screen shots, etc.) for
SupportLine, and zip it up ready to attach to an incident raised with Micro Focus SupportLine.
5. Remove the –debug option from the Target field.

AccuRev Server Logs
You will find the AccuRev Server log information in a subdirectory of the AccuRev database directory,
which is by installation default: C:\Program Files\AccuRev\storage\site_slice\logs.
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